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This Manual contains information for the FTE-7800 which is an OTDR, CWDM Channel Analyzer, Broad Band 
Power Meter, Stable Light Source, Visual Fault Locator and Video Scope contained in one unit.  The beginning of 
the manual contains general information pertaining to the physical features of the equipment.  Please refer to the 
appropriate chapters for information on the operation of each individual function.      

There are warnings, cautions and notes annotated through this manual.  

Warning
A warning alerts to situations that could cause personal injury.  

Caution
A caution alerts to situations that may cause damage to the equipment or produce poor testing conditions 
resulting in inaccurate test results.

Note
A special annotation that will assist the user with operational features.

Chapter 1  Using This Manual
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This product has been designed and tested in accordance with the Manufacturer’s safety standards, and has 
been supplied in a safe condition. 

This document contains information and warnings that must be followed by the user to ensure  safe operation 
and to maintain the product in a safe condition.  Failure to follow these safety warnings, can result in damage to 
the instrument or harm to the user.

Warning
Personnel should always be aware when working with fi ber optic test equipment that active fi bers  may be present 
and therefore infrared optical energy may be present.     

Warning
Never look directly into the end of a connected fi ber optic cable or fi ber optic adapter of test equipment, to do so 
could expose the user to laser radiation and could result in sever personal injury.

Warning
To Prevent Fire or Shock Hazard:

Chapter 3 of this manual is a quick start guide.  Prior to using the quick start guide or operating the equipment in 
any way, it is highly suggested the user reads all safety information.

Chapter 2    Safety

Do not install battery types other than those specifi ed by the manufacturer 

Do not use the charger without the batteries installed  

Do not expose the battery charger to rain or excessive moisture 

Do not use the AC adapter when there are signs of damage to the enclosure or cord 

Ensure that you are using the correct charger for the local line voltage  

Do not use any other charger than the one provided with this instrument. 



FTE-8000 Users Guide Revision C  3/2012 3

Failure to follow these cautions statements may void the warranty of this equipment. 

Caution
The FTE-8000-DWDM has two ports,  a low power and high power port.  The low power port is designed for 
maximum power of -10dBm per channel and a maximum composite power of +22dBm.  The high power port is 
designed for a maximum of +10dBm per channel and a maximum composite power of +29dBm.  If unsure of the 
power level, it is best to start in high power mode and use the designated high power port. Please refer to section 
8.2 of this manual for instructions on setting the power level. 

Caution
Fiber-optic connectors are easily contaminated or damaged.  The connection to the FTE-8000 is a physical 
contact type of connection and dirty or damaged connectors may impair the instruments capabilities at minimum 
and at worst result in the need to return the FTE-8000 to the factory for expensive repairs.  Prior to making any 
connection to the unit, ensure that all proper cleaning procedures have been followed. Use UPC Finish Connec-
tors Only!

Caution
The FTE-8000-CWDM maximum power per channel is +5dBm and the Maximum Composite power is +23dBm.   
Attempting to test greater power levels will cause damage to this instrument.

Chapter 2    Safety Continued
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3.0 Quick Start Guides

Chapter 3   OTDR Quick Start Guides

3.1 OTDR Quick Start Guide

Press  to turn on the OTDR.  

The OTDR function will be highlighted.  Press  to initiate the OTDR application.
Connect the fi ber to the appropriate port. (Select Multi Mode or Single Mode if OTDR is a quad wavelength unit) 

Press  to enter the Menu mode.

Use the Scroll Wheel to highlight the   in the icon list.

Press   to cycle to the desired wavelength.  The OTDR will start a scan at the parameters displayed.  
    If approximate fi ber length is not known: 

Press the  button after selecting the wavelength, (Press  on Range Finder) the Auto Test feature will start 
and set an appropriate pulse width and range automatically. 
If approximate fi ber length is known:

Press and scroll to:    

  Press  to cycle through the averaging times of - R/T for real-time, Short for a 10    
second average time or Long for a 5 minute averaging time.

 Press  to cycle through the pulse width - select 2m for fi bers up to 4 kilometers, 10m    
for fi ber up to 16 kilometers, 100m for fi bers up to 64 kilometers or 1k for fi bers up to 2   40 
kilometers. 
 

 Press  to toggle between to available range settings.

Press   to exit the menu mode.
To manually start a scan:   Press    while the unit is idle.
To stop a scan:     Press    while the unit is scanning.
To view the Event table:   Press  to enter Menu mode and use      
    the Scroll Wheel to highlight the Show        
   Event soft key and press the  button to        
  change to  the event analysis mode.  
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Chapter 3    Quick Start Guides Continued

3.2 Loss Test Set Quick Start Guide

Press   to turn on the OTDR. 
 
Use the Scroll Wheel to highlight the LTS function icon and press  . 

Connect a properly prepared reference cord to the power meter port and the light source port.  (If the unit is a 
quad wavelength unit, ensure the proper port is connected)

Press   and use the Scroll Wheel to highlight the Source soft key at the top left of the display.  

Press   to energize the fi rst wavelength. Once stabilized, use the Scroll Wheel to highlight the   icon on the 
right side of the display.  Press   to set the reference for that wavelength.  If a second wave length is going to 
be tested, scroll back to the Source soft key and press   to cycle to the next desired wavelength and repeat the 
step to set the reference. 

Press     to exit the Menu mode.

To conduct a Manual Test

If using the OTDR as the light source, perform 
reference procedure as above and place fi ber under 
test in line between the reference cord and the 
power meter port.  Ensure you are in Menu mode 
and Scroll to Source soft key.  

Press  to cycle through the wavelengths and 
choose the wavelength to be tested.

Press  to exit Menu mode.

Press  to store the measurement to the location 
indicated in the bottom left of the display.

To conduct an Auto Test

Note: Setting a reference in Auto Test mode is not 
necessary.  The source is modulated and a Refer-
ence of -3dBm (-6dBm-1625) is assumed.

Connect fi ber to be tested, press the  button 
and the light source will cycle to test each wave-
length, the power meter will read the signal and 
hold test in temporary memory until the  button is 
pressed and the test is stored into the memory 
location indicated at the bottom left corner of the 
display.  

Ensure that the unit has cycled through all the 
desired wavelengths prior to pressing the select 
button. 

Auto Test will be displayed at the bottom of the 

display to indicate the Auto Test Mode. 
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Note
There is an activity indicator in the bottom left of the display, (see figure.8.3)  When the indicator is red, 
the unit is ready to scan, to start scanning, press the Scan button.  When the Channel Analyzer is scan-
ning, the activity indicator will be green

3.3 CWDM Channel Analyzer Quick Start Guide

Press   to turn on the FTE-7800 

The number of channels displayed may be limited by using the Span Start ,  Span End  or Span Zoom  

features.  These features are fully described in section 8.4 of this manual.

Note
Scale Minimum Power and Span Minimum power are not applicable on the FTE-8000-CWDM Channel Analyzer.

Using UPC fi nish connectors only, connect the fi ber to be tested to the “CWDM Optical Port” and press the button 

to start a scan.

Chapter 3    Quick Start Guides Continued
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Chapter 4  Introduction

Thank you for purchasing the FTB-7800 multi-tasker, the world’s first handheld test and measurement 
product dedicated to assist you with installation, commissioning and maintenance of the next-gen fiber 
optic networks. If you’re working with upgrading an overburdened network with additional optical chan-
nels or installing the latest generation of multichannel high bandwidth fiber links, the multi-tasker will 
assist with meeting your test and measurement needs quickly and efficiently.

The FTB-7800 includes the latest extended dynamic range, high resolution Optical Time Domain Reflec-
tometer (OTDR) technologies as the base platform. As with all of TTI’s newest developments, we have 
incorporated the standard features including Instant-on, autotest and immediate event analysis for fast 
and trouble free visibility of network distance and loss measurements. Also this instrument includes the 
standard capabilities of the stabilized singlemode light source with autowave capability, the matching au-
towave broadband power meter to complete the Loss Test Set (LTS) function, a visible fault locator (VFL) 
source for nearby fault isolation and fiber identification, and the video scope option for end face analysis. 
New to the FTB-7800 is the inclusion of the 8 channel ITU grid multi spectrum (OSA) power analyzer 
for simultaneous measurement of the upper 8 CWDM wavelengths utilized in the latest high bandwidth 
networks.

The multi-tasker provides a startup menu to select from the OTDR, VFL, LTS, SCOPE, and OSA function 
immediately upon energizing. This feature is coupled to each instrument for immediate analysis of impor-
tant features of your link. Before connecting the instrument to your fiber under test, it is good practice to 
examine the optical patch connectors with the optional high resolution 200x or 400x video scope probe 
and collect an image to attach to your link documentation. For basic link analysis the OTDR can then be 
connected and an autotest can immediately provide link loss and distance results on single mode fiber at 
the popular 1310nm and 1550nm wavelengths. The construction mode can be selected to automatically 
collect and file both fiber signatures.

The on-board Loss Test Set completes the standard package of documented results necessary to com-
mission a system, or can be utilized for pass fail analysis of network power throughput. The advanced 
autowave feature is a must to improve the efficiency and reliability of measuring at both 1310nm and 
1550nm radiation, but as a broadband power meter it is calibrated for system end to end loss analysis at 
all popular fiber optic wavelengths with your sources.

For commissioning or troubleshooting a multi-wavelength system, the 8 channel CWDM can be utilized at 
various points to detect proper power levels from each source and appropriate add/drop connectivity set-
tings at each adjustable node on the network. The channel analyzer provides immediate real time power 
measurement results of all 8 channels from 1471nm to 1611nm simultaneously and also analyzes and 
displays statistical measurements at each ITU grid channel. Of course documentation of all these results 
is accomplished at the push of a button.

TTI has many advanced measuring instruments for use with multiple wavelength multimode and sing-
lemode systems from CWDM wavelength OTDR analyzers, DWDM MiniOSA devices, DWDM Tunable 
Laser sources, Variable Optical Attenuators, Loss Test Sets, Video Scopes, as well as PON OTDRs with 
1625nm active out-of-band coverage. Please enjoy the use of your new FTB-7800 multi-tasker, and again 
thank you for considering TTI. Please follow the next section’s simple startup instruction to get right to 
work with your TTI test and measurement equipment.
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Before shipment, this instrument was inspected and found to be in perfect working order and free of defects.

The shipping carton contains the following:

1.   Hand Held OTDR/OSA, with protective boot and 8-AA NiMH batteries installed

2.   Universal AC/DC charger with interchangeable mains

3.  USB cable

4.   Manual on CD with Windows™ compatible software and user’s manual

5. Set of interchangeable adapters, SC and FC, for each OSA port.

 Fig 5.1

Chapter 5   Preparation For Use

5.3   Inspection

The instrument’s Model/Part Number, Serial Number and Date of Manu-
facture are indicated on a label located on the bottom plate of the unit. 
The instrument’s history is fi led at the factory by model/part number and 
serial number.

5.2   Identification and Configuration

5.3 Power Requirements

The FTE-8000 is equipped with a 100-240V-0.4A input and 13.6V, 0.75A, center positive output universal AC/DC 
battery charger.  This charger is supplied with interchangeable mains for US, Great Britain, Europe and Australia 
The unit is shipped with 8-AA NiMH batteries (2700mA hours).   Depending on usage, fully charged battery pack 
will typically enable approximately 8 hrs. of use. Fully discharged batteries require 6 - 8 hours of recharging.
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Battery replacement is not recommended; however, if you must replace the batteries, follow this procedure.  
Unplug external power supply and ensure the unit is turned off.  Carefully remove unit from protective boot and 
remove the two screws from top plate and bottom plates that retain the back cover. Carefully remove back cover 
and remove the two screws that hold the battery covers in place.  Replace only with 8 high quality AA NiMH bat-
teries. Do not use batteries that are rated at less the 2500mAh.  If you install NiMH batteries that are dead or less 
than 1 volt each, charge these batteries for one (1) hour before using the unit. For maintenance, batteries require 
a monthly periodic recharge.

Chapter 5   Preparation For Use Continued

Warning
To Prevent Fire or Shock Hazard:

Do not install battery types other than those specifi ed by the manufacturer 

Do not use the charger without the batteries installed  

Do not expose the battery charger to rain or excessive moisture 

Do not use the AC adapter when there are signs of damage to the enclosure or cord 

Ensure that you are using the correct charger for the local line voltage  

Do not use any other charger than the one provided with this instrument. 

Failure to follow these caution statements may void the warranty of this equipment. 

5.3 Power Requirements Continued
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6.1 Instrument Description

Insrument Enclosure
The FTE7800 is packaged in a rugged aluminum housing which is further protected with a rubberized boot.  Al-
though the front panel is weather resistant, care must be taken to avoid liquids and contaminants around the frag-
ile optical and electrical connectors, and the glass display. Use a mild cleaning agent and damp soft cloth to clean 
up the panels and the outside case. See the maintenance section to clean the optical connector. NEVER open the 
instrument for cleaning. Return to the factory for servicing if necessary.

Display
This units is equipped with a 4” color TFT display

Key Pad
The FTE7800 is equipped with a 7 button key pad.  For a full description of functions, please see the section of 
the manual that is dedicated to function being operated.

Scroll Wheel
The scroll wheel is used to navigate through menus, move cursors and make adjustments to settings.

Chapter 6   Description

6.2   Physical   

Front Panel

Display

Key Pad Scroll Wheel

Fig  6.1

Charge Indicator
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Top Plate

VFL PORT OTDR Port

Power Jack

Bottom Plate

USB Flash

USB PC Port

Fig 6.2

Fig 6.3

6.2   Home Page

Chapter 6   Description Continued

Video Probe Port

Power Meter PORTCWDM PORT

Visual Fault  Locator 
Button

Optical Spectrum 
Analyzer Button

Version 
Number

Optical Time Domain 
Refl ectometer Button

Loss Test Set Button Video Scope Button

Battery Level Indicator

Fig 5.4
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Chapter 6  Description

7.1  Icon Defi nitions

Help Feature Accesses the help fi les

LSA Adjustments Used to adjust the LSA splice loss areas

File Management Used to enter the File Management

Tool Box The Tool Box contains equipment features, and operational parameters that are 
seldom changed

The list below and on the next page contain the icons found  on the FTE-8000 units.  They control features and 
functions, and allow the user to set testing parameters. This table gives the name and a brief explanation of each.  
More detailed explanations will be found in later sections of this chapter and in chapters to follow.

Date/Time Used to set the time/date

Back Light Toggles on and off the back light

 Speaker Toggles on and off the speaker

Baud Rate Used to manually set the baud rate for USB/PC communications

Home Returns the user to the Home Menu

Setup Icons

OTDR Icons

Resolution Used to set the OTDR to Low or High Resolution

Unit of Measure Use to set the Unit of Measure to Kilometers, Kilofeet or Miles

Cursor Lock Used to Lock the “A” and “B” cursors movement

Loss Mode Used to Select Splice or LSA loss modes or to disable the loss mode

Calibration This is reserved for factory use

OTDR Toolbox Icons

Continued
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Channel Analyzer Icons

Help Feature Accesses the help fi les

File Management Used to enter the File Management

Lambda Used to change channel measurements to wavelength or frequency

Home Returns the user to the Home Menu

Calibration This is reserved for factory use

Battery Icons Indicates the charge status of the batteries.  When operating on AC power, an AC 
plug will be displayed next to the battery.

Chapter 6   Description Continued

OTDR Icons Continued

Index of Refraction Used to set the Index of Refraction from 1.024 - 2.048

Lambda Cycles through the wavelengths available for use on the OTDR

Average Cycles through the average mode available 

Pulse Width Cycles through the available pulse with for a selected range

Range Cycles through the available ranges on the OTDR

Home Returns the user to the Home Menu

Battery Icons Indicates the charge status of the batteries.  When operating on AC power, an AC 
plug will be displayed next to the battery.
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Help Feature Accesses the help fi les

File Delete Delete Loss Test Set fi les

File Download Download File to the computer via USB cable

Lambda Used to fi lter power meter wavelengths out of Autotest Mode.

Reference Used to set nonvolatile reference

dBm/dB Used to set measurement unit to dBm or dB

Calibration This is reserved for factory use

Home Returns the user to the Home Menu

Battery Icons Indicates the charge status of the batteries.  When operating on AC power, an AC 
plug will be displayed next to the battery.

LTS Icons

Chapter 6   Description Continued
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Battery Level/Power Indicator
The bottom right hand corner of the screen shows the battery level indicator.  In the fi nal hour of operation the bat-
tery will change to red. A warning indicator will sound a few minutes before the instrument automatically turns off.  
An AC plug will be displayed next to the indicator bar if the unit is operating with the AC power supply/charger.
There is also a red charge light in the top right corner of the front panel.  This will glow red when the unit is charging.  
 

USB Flash Drive 
Located on the bottom panel is the USB Flash Drive port.  Scan fi le and Scope fi les may be downloaded the ex-
ternal memory device.  Screen Shots are downloaded directly to the USB fl ash drive. 

USB/PC 
Located on the bottom panel is the USB/PC port which may be used to connect the Optical Spectrum Analyzer to 
a computer to download stored data for analysis with the supplied Windows™ compatible software.  

Chapter 7  General Features and Setup

7.2   General Features and Setup

Caution 
 Ensure the unit is turned off before plugging or unplugging the AC power supply/charger.

Note
Flash drives of 4 GB or less are supported.

7.3 Setup Menu Features

The following features are accessed from the setup menu.  To access the  setup menu, press the Menu button 
while on the Home Screen. To exit the setup menu at any time press the Menu button again.

Set Date and time
The FTE-8000 applies a time/date stamp to the saved Scans.  The date is confi gured MM/DD/YY  and the time 
is a 24 hour format set in the eastern time zone. To change the data and time, Press the Menu button to enter 
the menu mode, scroll to the Clock icon and press the Select button.  The dialog box with the settings will be 
displayed.  Use the scroll wheel to change each segment, use the Select button to move between segments, and 
to Save/Redo/Cancel.  Use the scroll wheel to select  Save, Redo or Cancel then press the Select button again 
to complete setting the date and time.   This setting has a memory of approximately one month of no instrument 
activity.  To recharge the memory, turn the instrument on for 5 minutes per month or during the monthly battery 
charge if the unit is not used for a long period.
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Brightness
To set the Back Light press the Menu button to enter the menu mode, scroll to the Tool Box icon, press Select 
and use the scroll wheel to highlight the Backlight icon, press the Select button to toggle the back light to Bright or 
Dim.  The status is displayed at the top of the display.  Press the Menu button to exit the Tools Box.  

Sound
To toggle the speaker on or off, press the Menu button to enter the menu mode, scroll to the Tool Box icon, press 
Select and scroll to the Speaker icon, press the Select button to toggle the speaker on and off.  The status is dis-
played at the top of the display. Press the Menu button to exit the Tools Box.

Baud Rate
The Baud rate is set to auto detect for use with the software.  If it is necessary to make an adjustment to the Baud 
rate, press the Menu button to enter the menu mode, scroll to the Tool Box icon, press Select and use the scroll 
wheel to highlight the Baud Rate icon.  Press Select, use the scroll wheel to make a selection, press Select again 
and the unit will exit to the menu mode and return to the main screen.

Home
Highlight the Home icon and press Select to return to the home page

Chapter 7   Features and Preferences Continued

General Features and Setup Continued
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Chapter 8 OTDR Operation

7.0  OTDR Operation

7.1 Key Pad 

Power button, turns the unit On and Off. (Hold for 1 second)

  
  
This key will start a scan or stop the current scan. 
                                                                                                                                   
             
     
This key starts autotest range fi nder and construction mode scans. The range fi nder checks test   condi-
tions and starts a scan at the wavelength selected by the user but allows the OTDR to determine  
the pulse width and range parameters.  The AutoTest button is also used operate the construction mode.   
The fi rst time this button is selected in a user session, a dialog box will be displayed asking the user to   
choose between range fi nger and construction mode. If during a user session it is desired to change the   
value of this button, holding it down for greater than one second will recall the selection dialog back to       
the screen allowing the user to change the function of the button.

Toggles between the Trace Mode where the focus of the  Scroll Wheel and the Select Button are on the      
active cursor and the Menu mode where the Scroll Wheel moves through the Soft Key Menu and the      
Side Icon Bar. 

Toggles between A and B as the active cursors.

  

Selects the Zoom level, each press increments through  the levels of 1x, 2x, 4x, 8x, 16x and 32x.

While in Trace Mode the Select button will move the  "Active" cursor to the next event. While in Menu 
Mode,  the Select button actuates highlighted item.     

 

While in Trace/Graph Mode the capacitive scroll wheel moves the A and B cursors.  While in Menu 
Mode it highlights soft keys and icons and while in Table Mode it highlights fi les and events.
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7.1 OTDR Display 

“B” cursor

Zoom Status 
and Grid Values

Parameter Settings 
(see fi g. 7.4 for more 
detail)

“A” Cursor

Measurement Area 
(see fi g. 7.3 for more detail)

Battery Status

Trace display

Trace Measurements

Trace Parameters

“B” Cursor 
Splice Loss

“A to B” 
2 Point Loss

Index Of Refraction

“A” Cursor 
Splice Loss

“A to B” 
Distance

dB Loss 
Per Unit of Measure

Wavelength Setting

Averaging Mode

Pulse Width  Setting

Range Setting
Fig  7.4

Fig  7.3

Fig  7.2
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OTDR Display with Menu Open

Menu icons

Soft Keys

Fig  7.5

7.3  OTDR Tools Menu 
Below is a list of the settings available through the Tools Menu in the OTDR mode.  Press the Menu button to 
open the Menu mode, scroll to the Tools icon and press the Select button.  Scroll to the desired setting and press 
Select to open.

Resolution
The resolution tool should be highlighted. Use the Select button to toggle between Low and High.   This resolu-
tion feature affects the ranges of 4km and 16km.  At low resolution 4km range, data points are ¼ meter apart and 
at high resolution, the data points are 1/8 meter apart.  At 16km range, the low resolution date points are 1 meter 
apart and at high resolution the data points are 1/8 meter apart.

Unit of Measure
The distance unit of measure may be either displayed in Kilometer (Km), Kilo feet (Kf) or Mile(Mi).  Scroll to Unit 
of Measure icon and use the Select button to toggle between Km, Kf or Mi. Press the Menu button to return to the 
trace display.

Cursor Lock
The cursors may be lock for accurate measurements.  To lock the cursors press the Menu button, scroll to the 
Tools icon and press the Select button.  Scroll to the Cursor Lock icon and press Select to toggle the lock cursor 
mode on and off.  In the lock cursor mode, with the A cursor as the active cursor, both A and B cursors move and 
with the B cursor as the active cursor, the B cursor will move independently in order to set the distance between 
the two cursors
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OTDR Tools Menu (continued)

Loss Mode
Loss Mode setting allows the user to set the splice loss measurement to be displayed to either simple splice loss, 
LSA (least squared averaged) or shut off this measurement to limit the amount of information on the display. 

Splice Loss 
Splice Loss method is meant to be used in noisy environments when it is diffi cult to attain an LSA area that lays 
fl at on the back scatter before and after the cursor.  See section 7.8 - Setting Splice Loss Measurement Areas. 
This method takes an average of the selected points before and after the active cursor and uses this average to 
make a good estimation of the event loss.  This is an estimation but this method may be more accurate than LSA 
Splice Loss method in noisy environments.

Least Squares Approximation (LSA) 
LSA Splice loss method gives the user a visual aid in setting splice loss areas. The splice loss lines must be set 
to overlay the backscatter of a trace without over lapping any other events. The LSA areas are set properly when 
the LSA visualization lines overlay the back scatter sections of the trace before and after the event.  This method 
can be more accurate by affording the ability to see the slope of the splice loss areas, however: it can also supply 
a reading with greater error if not used properly. Please see Fig 7.3, 7.4 and 7.5 for examples of LSA settings. In 
Noisy environments the LSA Lines will have an exaggerated movement making the Basic Splice Loss Measure-
ment potentially more accurate.  

The Splice loss measurement may also be disabled if these measurements are not require for testing.  

Enter Calibration 
 This tool is for factory use.

7.4  Auto Test 

Warning
Clean connector thoroughly prior to connection to the appropriate port of the OTDR.  Failure to ensure 
the connectors used with the OTDR are properly cleaned can result in poor launch conditions at the mini-
mum or damage that requires the unit be returned to the factory for repair.

Warning
Before connecting to a patch cord or fiber under test, be certain the fiber has no active optical sources or 
instruments connected to the other end. Skin or eye damage could result from other high power sources 
e.g. EDFAs, or instrument damage could occur voiding the warranty.

Note
The first time Autotest is press upon power-up, a dialog box will be display to set the function of the but-
ton. Use the scroll wheel to move between the Range Finder and Construction Mode. Press the Select 
button once the desired function is highlighted.  To change the function once set in a user session, press 
and hold the Autotest button and the dialogue box will be displayed again.
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Range Finder
This is a useful feature when the approximate length of the fi ber to be tested is unknown.  The Range Finder 
feature tests at the wavelength selected by the user.  To set the wavelength, press the Menu button, scroll to the 
Lambda icon and use the Select button to cycle to the desired wavelength.  Press the Autotest button, the unit will 
set the average time to short, starts a scan and fl ashes Auto in the pulse width and range parameters.  When Auto 
stops fl ashing the unit has set the pulse width and range, then completes the test and displays the trace.   
 
Construction Mode
This is useful when a large number of fi bers need to be tested with the same settings at multiple wavelengths.  
To operate in Construction mode, set the Autotest button to construction mode in the manner described above.  
The Construction Mode tests up to two wavelengths at one time, displays the two traces and saves the traces to 
the next two available storage locations.  

Follow these procedures to test in Construction mode:

Set The Wavelengths:
Set the wavelengths to be tested by pressing the Menu button, scrolling to the Tools icon and pressing Select.  
Scroll to the Set Wavelength Filter tool and press Select.  Grayed out wavelengths are turned off. The wave-
lengths in black text are active. To select wavelengths, scroll to highlight the wavelength and press the Select But-
ton. To complete the process, scroll to Save and press select.  Press Menu again to close the Tools dialogue box.

Set Test Parameters:
Check the Average Time, Pulse Width and Range to ensure they are set properly.  Refer to section 7.4 for instruc-
tions on setting these parameters. 

Note: Real Time is not recommended as an averaging time for Construction mode.  

Set The File Name:
It is necessary to set the base fi le name prior to starting the test.  To establish the fi le name, press the Menu 
button and scroll to the File Management icon and press Select.  Scroll to an empty fi le location and press Se-
lect.  Name the fi le by using the scroll wheel to display the desired letter or number and press Select to move to 
the next Character.  Do not press select to enter the last character.  Once it is displayed, press the Menu button 
and Save Changes soft key will be highlight, press Select or use the Scroll Wheel to select Discard Changes and 
press Select.  All future fi les will use the new base fi le name until it is change.  The fi le that was just created may 
be deleted if desire by following the procedures in section 10.9. Auto Test (continued)

Set Default Notes:
To enter default notes for trace fi les, enter the File management as above and scroll to any empty location.  Press 
the Menu button, scroll to the Notes soft key and press Select.  The fi rst Character of the note box is highlighted.  
Use the Scroll Wheel to select the desired character and press select.  Continue on until the note is complete.  
To erase the characters and move forward, use the “blank”.  To quickly return to the beginning of a note, press 
the Menu button and then the Select button on the Notes soft key.  To exit the Notes box, press the Menu button.  
This note will now be the default note for all traces until it is change
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Conduct The Tests:
Connect a fi ber to the proper test port and press the Autotest button.  The OTDR will conduct the test at the fi rst 
wavelength and store the trace in temporary memory using the base fi le name given, with default notes attached. 
The second wavelength is then started and once complete the traces stored to memory, and then both traces are 
displayed for review. 

Disconnect the fi ber, connect the next fi ber and press Autotest.  The two tests will be completed stored and dis-
played.  Continue on until all fi bers are tested.  

7.5  Manual Scan Setting
After powering on the OTDR, Enter the menu mode by pressing the Menu button and scroll to the parameter keys  
to set all the necessary parameters to the appropriate values.  
 
These parameters include:  

Resolution 
Enter the Menu mode, scroll to highlight Tools icon and press Select.  The resolution tool should be highlighted. 
Use the Select button to toggle between Low and High.   This resolution feature affects the ranges of 4km and 
16km.  At low resolution 4km range, data points are ¼ meter apart and at high resolution, the data points are 1/8 
meter apart.  At 16km range, the low resolution date points are 1 meter apart and at high resolution the data point 
are1/8 meter apart. 
 

Note
The resolution setting does affect speed and internal storage capability.  At the 16km range, high resolu-
tion vs. low resolution, the trace could take up to 8 times longer to complete and trace file sizes could 
be up to 8 times larger, decreasing file storage capability.  High resolution mode at the 4km range could 
cause the trace time to double as well as the file size.  To determine the amount of trace memory avail-
able, enter file management, scroll to the view tab and select “Stats” from the drop down menu.  This will 
show the number of traces saved and the number of traces that can still be saved in the internal memory.   

Note
To determine the amount of trace memory available, enter file management, scroll to the view tab and 
select “Stats” from the drop down menu.  This will show the number of traces saved and the number of 
traces that can still be saved in the internal memory.  

IOR
It is necessary to have the Index of Refraction set as close as possible to the actual IOR of the fi ber.  If this is 
unknown it is best to use the default setting on the OTDR.  To change the IOR, highlight the IOR icon and press 
the Select button.  Use the Scroll wheel to change the IOR value.  When the desired value is reached, press the 
select button again and the OTDR will prompt the user to save or cancel the changes.  Use the scroll Wheel to 
highlight desired action and press the Select button.  

Wavelength
Use the scroll wheel to highlight the Lambda key, press select to cycle through the available wavelengths.  
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AVG 
Use the scroll wheel to highlight the Average (AVG) icon and use Select button to cycle through, Real-time  
averaging, with a up to 2 pps  refresh rate,  Short average (~30 seconds) or long average (~10 minutes).    
Changing this setting will also initiate a scan.

Pulse Width
Use the scroll wheel to highlight the PW icon and use the Select button to cycle through the available pulse widths 
for the selected range. The pulse widths are listed in the table below.

Range
Use the scroll wheel to highlight the RNG icon and use the Select button to choose the desired range.  Available 
ranges are listed in the table below.  

R
an

ge

5ns 10ns 30ns 100ns 300ns 1μs 3μs 10μs 20μs

1km
4km
16km
64km
256km

Pulse Width

7.6  Viewing  Traces
 
Zoom
There are fi ve zoom levels, 1x, 2x, 4x, 8x, 16x and 32x.  The current level is indicated in the bottom right corner 
of the display with the values per division.  Press the Zoom button to cycle through the zoom levels.  When in the 
Menu mode, pressing select while the Zoom soft key is highlighted will also cycle through the zoom levels.

Note
The values per division change with each change of the zoom level and are indicated in the  lower 
right corner of the display

Z oom Bar
The bottom most portion of the trace is a Zoom Bar.  This represents the entire range of the trace being viewed.  
The green bar within the area represents the amount of the trace that is being viewed whiled the zoom func-
tion.  While in Zoom level 1x the green bar will fi ll the zoom bar area meaning the entire range of the trace can be 
viewed and in Zoom level 2 the green bar will fi ll only half of the zoom bar area, meaning half of the entire range 
of the trace can be viewed. As the zoom levels increase, the green zoom bar will  decrease in size to indicate the 
amount of the trace that can be views at one time.  As a cursor is moved with the Scroll Wheel, the green zoom 
bar moves to indicate what portion of the trace is being seen. For example, if the  green bar is to the left of the 
zoom Area, the beginning portion of the trace is being viewed and if the green bar is to the right of the zoom Area, 
the end of the trace is being viewed.  
 
Cursor movement 
The active cursor is shown as a solid line while the inactive cursor is a dashed line.  When in the Menu mode an  
“A” or “B” will be displayed next to the Cursor soft key as in indication   Press the A/B button to toggle between the  
cursors. When in the Menu mode, pressing select while the Cursor soft key is highlighted will also toggle the  
active cursor.

Fig  7.6
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Note
To quickly move the active cursor to the next event, press the Select button while the unit is in the trace 
view mode.

Cursor Lock
The cursors may be lock for accurate measurements.  To lock the cursors press the Menu button, scroll to the 
Tools icon and press the Select button.  Scroll to the Cursor Lock icon and press Select to toggle the lock cursor 
mode on and off.  In the lock cursor mode, with the A cursor as the active cursor, both A and B cursors move and 
with the B cursor as the active cursor, the B cursor will move independently in order to set the distance between 
the two cursors. 

7.7  Unit of Measure
The distance unit of measure may be either displayed in Kilometer (Km), Kilo feet (Kf) or Mile(Mi).  To change 
the setting,   enter the menu mode, scroll to highlight the Tools icon and press the Select button.  Scroll to Unit of 
Measure icon and use the Select button to toggle between Km, Kf or Mi. Press the Menu button to return to the 
trace display.

7.8 Loss Measurements 
Set Viewable Measurements
The Precision Rate Optics OTDR allows the user to set which loss measurements will be displayed.  The loss 
measurements seen are splice loss for both cursors, dB value between cursors, distance between cursors and 
dB per Km or Kf.  If any of these measurements are not of importance for a Series of test, one or more may be 
turned of for ease of viewing.  To accomplish this, highlight Set Viewable Measurements icon and press Select.  A 
box will be drawn around the splice loss measurements. Use the Scroll wheel to cycle the measurement between 
Splice Loss, LSA Splice Loss or off.  Press Select to move to A-B Loss and distance.  Again use the Scroll Wheel 
to turn these settings on or off.  Press Select again to move to the dB/KM (KF) and use the Scroll Wheel to turn 
this value on or off.  Press the Menu button at any time to exit this feature. 
 
 Loss Mode Defi nitions

• 2 Point loss method takes the difference in vertical height between where the A and B cursors cross the 
trace to determine the amount of loss in that section of fi ber.
• The dB/Km (dB/Kf) loss method takes the 2 Point loss in dB and divides by the distance between the cur-
sors in Kilometers (Kilo feet). For accurate dB/Km (dB/Kf) loss measurements, the two cursors must be on level 
backscatter points at least 100m apart (NA will be shown for distances that are too short).
• Splice Loss method is meant to be used in noisy environments when it is diffi cult to attain an LSA area 
that lays fl at on the back scatter before and after the cursor.  See section 7.8 - Setting Splice Loss Measurement 
Areas. This method takes an average of the selected points before and after the active cursor and uses this aver-
age to make a good estimation of the event loss.  This is an estimation but this method may be more accurate 
than LSA Splice Loss method in noisy environments.
• Least Squares Approximation (LSA) Splice loss method gives the user a visual aid in setting splice loss 
areas. The splice loss lines must be set to overlay the backscatter of a trace without over lapping any other 
events. The LSA areas are set properly when the LSA visualization lines overlay the back scatter sections of the 
trace before and after the event.  This method can be more accurate by affording the ability to see the slope of the 
splice loss areas, however: it can also supply a reading with greater error if not used properly. Please see Fig 7.3, 
7.4 and 7.5 for examples of LSA settings. In Noisy environments the LSA Lines will have an exaggerated move-
ment making the Basic Splice Loss Measurement potentially more accurate.  

7.9 Setting Splice Loss Measurement Areas 
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7.9 Setting Splice Loss Measurement Areas   
LSA Set Too Early

    
                    
 

LSA Set Too Late

     

   

   
Proper LSA Setting

                     

The LSA area and cursor are set 
too early. The right most green 
LSA indicator line is not over lay-
ing the back scatter of the trace 
properly

Fig  7.7

The LSA area and cursor are set 
too late. The left most green LSA 
indicator line is not over laying the 
back scatter of the trace

Fig  7.8

The LSA area and cursor are set 
properly.  The green LSA 
indicator line is over laying the back 
scatter of the trace properly.  

Fig  7.9
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7.10 Quick Save/Recall
Quick Save

To use quick save, press the Menu button, scroll to the Save soft key and press the Select button.  The trace 
will be saved to the storage location shown. The fi le will be stored with the same base fi le name as the last save 
stored trace.  If the storage location indicated already contains a fi le, the user will be prompted to either “Over-
write” the location, Save to the “Next” available location or “Cancel” the action.  Scroll to the desired action and 
press Select.  The storage location will increment accordingly.  

Note
There are sample traces stored on the OTDR at the factory.  These traces are saved in the with the base 
file name of default.

Quick Recall
To quickly recall a trace, press Menu, scroll to the Recall soft key and press the Select button to display the trace 
that is saved in the memory location indicated and the next memory location with a trace will be displayed.     
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8. 0  Event Analysis

NOTE
When using the event table, it is necessary to keep in mind that event analysis provides approximate  
loss and distance measurements to quickly assist in network evaluation.  Automatic detection results are 
not guaranteed and have their limits, possibly causing erroneous readings or detection failure. User inter-
action by interfacing with the trace display is recommended for final qualitative and quantitative analysis.

8.1 Enter Event Analysis Mode
 
To open the event analysis table, press the Menu button, scroll to highlight Show Event soft key and press  
the Select button.  Use the Scroll Wheel to move through the events.  If the Select button is pressed while  
an event is highlighted, The OTDR will revert to the Trace Screen with the active cursor positioned at the   
selected event.  An alternative method to return to the trace view is to press the Menu button, scroll to the  
Show Trace soft key and press the Select button.

8.2 Event Analysis Table 
   

    

         
 

  
   
    
     
   

      
     
           
            
                  
 

     

Fig 8.1

Soft Keys
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8.3  Field Descriptions
# (Event Number) 
Indicates the events in sequence, higher numbers are further distances from the OTDR. “E”, which is always  
displayed in the bottom row is the event determined to be the End of Fiber (EOF).

P/F (Pass/Fail)
Pass/Fail, if any one of the thresholds are not met for and event, the P/F column will display a red X.  The  param-
eter that failed will also be displayed in red.  If all the parameters are met, a green check mark will be  dis-
played.

KM (Event Location)
Event Location, Km for Kilometer or KF for Kilo-feet or Mi for Mile.  This is the distance/location that the  event 
occurs in the respective unit of measure.  
Field Descriptions (Continued)
 
SPLICE (Event Loss)
Event Loss, where a positive number is the amount of loss and a negative number would be indicating a gain.  
This is a settable threshold for the Pass/Fail feature.

2POINT (2 Point Loss)
Point Loss, which is measured from the end of the dead zone of the previous event to the beginning of current  
event. 

DB/KM  (dB Loss Per Km/Kf)
dB per Kilometer if in KM unit of measure and DB/KF if in Kilo-Feet unit of measure.  This is the calculated loss  
per Km or Kf from the end of the dead zone of the previous event to the beginning of the current event. 

TYPE (Event Type/ORL)
Event Type is the type of event or the ORL measurement.  If the event is no refl ection, “splc” will be displayed and  
if the event contains a refl ection, the ORL value will be displayed.  This is a settable threshold for  the Pass/Fail  
feature

E  (End Event)
The bottom row of the table is the loss and distance information as it pertains to the entire fi ber link.    KM column  
is the end of fi ber distance measurement, Splice column is not used, 2 Point is the measurement from the origin  
(OTDR) to the determined end of fi ber in the KM column. The dB/km column is that measurement for the entire  
link and in the Type column Link will be displayed.

Other Display Elements
To the right of the table is a scroll bar which will be active if the amount of events exceeds one page and below 
the scroll bar is an indication of what page is display per number of pages.  Also on the Event Table display are 
the parameter settings for the current trace.
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8.4  Pass/Fail Settings 
There are three levels of sensitivity while in the event table.  The sensitivity is set via the Sense soft key. Press 
the Menu button and Scroll Wheel to highlight the Sense key. Press the Select button to cycle through “Lo” (Low) 
for event with loss as low as approximately 0.5dB,   “Me” (Medium) with events with loss down to approximately 
0.2dB and “Hi”, for events with loss as low as approximately 0.1dB.  Medium and High sensitivity settings should  
be used for high signal level, low noise, long pulse, averaged traces.

8.5  Pass/Fail Settings
Splice, ORL and Link are all settable thresholds for Pass/Fail purposes. To set the thresholds, press the Menu 
button, scroll to highlight the desired soft key, press the Select button and use the Scroll Wheel to reach the de-
sired value.  Press Select button again to lock in the settings. If the trace fails any of the three thresholds, a red X 
will be displayed in the P/F column and the suspect threshold value will be displayed in red.  
 

  Examples:
  Splice:  If a splice needs to be less then 1dB, set the threshold to <1.0.     
   If 1.0 would be accepted, set threshold to 1.01db.  

  ORL: If an ORL needs to be less then -50dB, set the threshold to <50.  
   If 50dB is acceptable, set the threshold to <49.  

  Link:   If the link loss needs to be less then 20dB, set the threshold to <20.      
   If 20db link loss is acceptable set the threshold to <21.  

  End:   This threshold setting is the fi rst test to determine the end of fi ber. If set to 3dB, the fi rst   
   event that meets this threshold will be identifi ed as the end of fi ber.  
  
To return to trace view, press the Menu button, scroll to the Show Trace soft key and press the Select    
button.
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9.0  File Management 

9.1 Display

 

File Management Drop Down Menus

        

9.2  Entering/Exiting File Management 
Press the Menu button, scroll to highlight the TRC (Disc) icon and press the Select button.  For each test/fi le 
saved, an indication of wavelength, range, pulse width and a time stamp are stored.   The fi le name can have up 
to 16 characters using the following; 0-9, A-Z, a-z, _ (underscore) or blank.  To close the File Management Sys-
tem, press the Menu button, scroll to highlight the File Tab, scroll to Exit and press Select.  

Fig 9.1

File Management Tabs 
See Fig 9.2

Pulse WidthWavelength

Range Time 
Stamp

File Name

Context Sensitive 
Help

Defualt Notes
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9.3 Saving a Trace         
There are two methods to save traces.  The fi rst is the Quick Save method described in section 8.8.  The second 
method is to enter fi le management with a trace on the display, press the Menu button, scroll to the File Manage-
ment icon and press Select.   Press the Menu button to the shift the focus of the scroll wheel to the fi le manage-
ment tabs.  Highlight the File tab, press Select and with Save highlighted in the dropdown menu, press select 
again.  Use the scroll wheel to change the highlighted character.  With the desired character displayed, press 
Select to enter that character and the next character will be highlighted.  Continue until the desired fi le name is 
entered and press the Menu button.  Use the scroll wheel to highlight Cancel, Redo or Save and press Select.  

9.4 Renaming a Trace
Highlight the fi le to be renamed using the scroll wheel.  Press the Menu button and scroll to highlight the Edit 
tab.  Press Select and with Rename highlighted in the dropdown menu, press select again.  To leave a character 
unchanged, simply press Select on the highlighted character.  To change a character, use the scroll wheel to 
make the change and press select with the desired character displayed.  Continue until the name is entered, 
press the Menu button, scroll to select Save Changes or Discard Changes, and press Select.  

9.5 Viewing Saved Trace
To view a saved trace from internal memory, use the scroll wheel to highlight the desired trace and press the Se-
lect button.  The OTDR will revert to the trace view with the selected trace displayed and directly below the trace 
will be the trace name. “Load” located in the File dropdown menu may also be used to load a trace to the trace 
screen.  With the desired trace highlighted, press menu, scroll to the File tab, press select, use the scroll wheel to 
highlight Load and press Select.

9.6  Dual Trace
 

Note
To compare two traces, they must have the same range and resolution settings.  

With a trace on the display, enter the fi le management, highlight the trace to be placed in the background, press 
the Menu button, scroll to the File tab highlighted, press Select, scroll to Dual on the dropdown menu and press 
select again.  Both traces will now be displayed.  The primary or fi rst trace loaded is the black trace and the sec-
ondary trace is the green trace.  All values displayed are the values associated with the primary trace.  If the trace 
for the background does not have the same range or resolution as the main trace, a range mismatch message will 
be displayed.  Press the Select button to clear the message.  

To exit the Dual Trace mode, start a new scan or open a new main trace from fi le management.

9.7  Marking Traces for Mass Coping and Deleting
Scroll to highlight the fi rst trace to be copied or deleted.  Press the Menu button, scroll to the Mark tab and press 
Select.  To mark 1 or 2 fi les for mass copying, press the Select button and the highlighted trace will be displayed 
in red font.  Pressing select again will mark the highlighted trace and the next trace will be highlighted. (The high-
lighted fi le is not marked.)  Only those fi les in displayed in red are marked.  To mark a large number of fi les use 
the scroll wheel.  Scrolling down (clockwise) will mark a fi le and scrolling up (counter clockwise) will un-mark a fi le.  
Files may be skipped by shutting off the marking feature, scrolling ahead and turning the feature back on.  To do 
this, once the last trace of a section has been marked, press the Menu button, scroll to the next fi le to be marked, 
press Menu again, press Select or scroll to continue marking the fi les.  Once all the desired traces are marked 
they may be deleted or copied as necessary.
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9.8 Copying Traces

NOTE
Limit flash drives to 4 gigabytes.  It is suggested that new flash drive sticks be tested prior to use.  Save 
traces to the flash drive from the OTDR and test them on the computer with the supplied software to 
ensure they operate properly. 

NOTE
Do Not Remove USB Flash Device While The OTDR Attempts To Read Or Write To That Port.

Traces may be copied to the USB fl ash drive or to a PC for use with the certifi cation software.  The Certifi cation 
Software is required to copy trace fi les to a computer through the USB/PC Port.   With a trace highlighted or a 
group of traces marked, press the Menu button and scroll to the Edit tab, press Select, chose either Copy PC or 
Copy USB from the dropdown menu and press select.  

9.9  Deleting Traces
Traces may be deleted from the internal memory or USB fl ash drive.  With a trace highlighted or group of trace 
marked, press the Menu button, scroll to the fi le tab, choose Delete from the dropdown menu with the scroll wheel 
and press Select.  Use the scroll wheel to highlight Cancel or Confi rm Delete and press Select. 
9.10 Adding Default Notes
A note may be saved with a trace. With a fi le highlighted, entering a note will save that note for that one trace.      
With an empty fi le storage position highlighted, enter a note and this note will be stored with all traces until the 
note is changed or deleted.  To enter notes, while in the fi le management screen, press the Menu button, scroll to 
the Edit tab and press Select.  Use the scroll wheel to choose Notes from the dropdown menu and press Select.  
The fi rst character of the notes fi eld will be highlighted.  Use the scroll wheel to choose a character and press 
Select. To erase a character or enter a space, scroll back to the “blank” which is the fi rst character available.   If 
a mistake is made, it may be best to exit the Note fi eld by pressing the Menu button, and reenter the notes fi eld 
from the Edit dropdown.  Once you have completed the note, press Menu to exit.  

9.11   Accessing Flash Drive 
To access the fl ash drive, while in fi le management, press the Menu Button and scroll to the View tab, press Se-
lect and choose USB Stick from the dropdown menu.    To return to the internal memory, press the Menu button, 
return to the View dropdown and choose Internal.   All of the Tab functions available for the internal memory are 
also available for the Flash drive.

9.12 Internal Memory Statistics 
The amount of storage available in the onboard memory is found in the Internal Memory Statistics screen.  To 
view this screen; while in fi le management, press Menu, scroll to the View tab and select Stats from the dropdown 
menu. This will indicate the percentage of memory used and how many more traces of a specifi c range may be 
saved.
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10.0 Loss Test Set Description

10.1 Entering Loss Test Set Mode
The LTS application is entered from the Home Menu.  Use the Scroll Wheel to highlight the LTS application Tab 
and press Select.  From the OTDR application, press the Menu button, scroll to the Exit Icon and press Select to 
return to the Home Menu.  When in the Scope application, Press the Menu button, scroll to highlight the Return 
soft key and press Select to return to the Home Menu. 

10.1  Key Pad Operation

Power button, turns the unit on and off.

Resets any temporarily memory values before they 
have been stored with the select button.  

Starts the Auto Test function. The light source will be turned on and 
cycle through the wavelengths selected with the λ icon.

Toggles between the Test mode and the Menu mode where the focus of the Scroll Wheel and the Select 
Button are on the soft keys and icons. 

Cycles through the power meter wavelengths selected with the λ Icon.  When in the File Selection 
Screen this key will toggle through save values for a particular storage position.

Changes the display to the zoom screen where all stored test for a memory location are display. There 
can be up to 4 test stored per location.  

The Select Button will store all measurements in the temporary memory to the storage position shown the 
lower left corner of the display while in the Test Mode and while in the Menu mode it will activate an icon 
item or soft key.

The scroll wheel is only used when in menu mode while in Live Scan mode.  When in File View 
mode, it is used to move through soft keys and icons in Menu mode and scrolls though the stored fi le 
when not in menu mode.
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10.3  LTS Displays   
 LTS Measurement Screen Live Scan Mode

                                                            
 
                                 

                
         

                 

       

 

LTS File View Screen
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10.4 Soft Keys Operation   

Source
Enter the Menu mode and scroll to highlight the Source soft key.  Press the Select button to cycle through the  
available wavelengths. (See Lambda/wavelength icon information below) The displayed source wavelength is the  
active source.  Turn off all sources, by cycling to the “Off” position. 

Power Meter
Enter the Menu mode and scroll to highlight the Power Meter soft key.  Press the Select button to  cycle through  
the available wavelengths. (See Lambda/wavelength icon information below) 

Mode
Enter the Menu mode and scroll to highlight the Mode soft key.  Press the Select button to toggle between the 
Live Scan mode and File View mode.  

10.5  Loss Test Set Icon List
 
Help
The Loss Test Set has an onboard help feature.  To access the help feature, enter the Menu, use the scroll  
wheel to highlight the Question Mark Icon and press the Select button.  Scroll to the desired topic and press the  
Select button.  Press the Menu button again to exit the help feature.
 
Delete
Deleting a stored loss measurement is accomplished in the File Selector mode.  (See LTS File Selector operation,  
Section 11.4) To delete a measurement/s from a single memory location, while in the File Selector, select the  
desired test to be deleted, press menu scroll to the Delete icon and press select 

Note
There is not warning or confirmation necessary to delete one memory location.
 

To delete the all the memory locations at one time, follow the procedure above, however do so on and empty  
location.  When the Delete icon is select on the empty location, a Confi rm dialog with “Delete all fi les?” will be  
displayed and the option to Delete or Cancel the action. Press the Select button with the desired action  high-
lighted. 
 

Note
A loss measurement of (----) is not empty if there is a wavelength displayed to the right.  That would  
be a null measurement).  An empty location is (----) with no wavelength displayed to the right.

Measurements may also be deleted in the Quick File Locator.  With the storage location selected, press the Menu  
button, scroll to the Delete icon and press Select.  There is a time out on the Quick File Select.  If the display  
reverts to the test mode, before the delete button is selected, the fi le will not be deleted.  
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Lambda (Wavelength Selection)
Highlighting and selecting the λ Icon will display the Wavelength Selection menu.  Use the scroll wheel to highlight 
the wavelengths to be select for use with the light source and power meter and press the Select button to toggle 
them off and on. The selected wavelengths will be the only wavelengths tested auto test and the only ones avail-
able when cycling through the light source and power meter soft keys.  Highlight “Save Selection” at the bottom of 
the menu and press the Select button to save the setting and return to the Loss Lest Set mode.  

File Download
File Download is used to send the save Loss Test to a PC.  Once the FTE-7800A is connected to a computer with 
the certifi cation software running, enter the menu mode and highlight the File Download icon.  When directed 
to do so, press the Select button to immediately start a download to the computer via the USB cable. Press the 
Menu button to return to the test mode.

Set Reference 
This icon is used to set the reference for relative loss measurements.

dBm/dB 
This icon is used to toggle the power meter from absolute power referenced by dBm and relative power refer-
enced by dB. 

Calibration  CAL
This tool is for factory use only.

 
Exiting Applications
Press the Menu button, scroll to the Home icon and press Select.
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11.0 Loss Test Set Operation 

11.1  Power Meter Measurements 
Power Measurements
With the FTE-7800 in Live Scan,  connect the fi ber carrying the optical power to be measured to the Power Meter 
detector utilizing the appropriate adaptor. Select the power meter wavelength that matches the wavelength of 
the light being measured. The power reading will now indicate the optical power in units of dBm. The power will 
display an out-of-range condition indicated by a series of four dashes on the display if the signal is greater than +5 
or less than -77 dBm.  CATV versions are available upon request.

To save the power measurement to the storage location indicated below the STORE label press the Select button.  
The memory location will auto increment to the next available memory location.

Relative Measurements
To make a relative power measurement you must fi rst save the reference power level. To store a reference level, 
attach reference cord/s and energize the light source. Enter the Menu mode, scroll to Ref icon and press the 
Select button.  The reference is now stored in nonvolatile memory and displayed at the bottom right of the display.  
The units of the display will now change to dB. Subsequent readings will now be displayed in terms of dB relative 
to the stored reference value. A reference memory location is available for each selected wavelength.  A reference 
reading is required to change to dB measurement from dBm measurements.

Remove the connector from the power meter port and place the fi ber under test inline between the reference cord 
and the power meter port.  The reading displayed will be the loss of the fi ber under test relative to the reference.   
Ensure the unit is not in Menu mode and press the Select button to store the measurement.

Stored power measurements may be recalled by moving the Scroll Wheel and the File Selector Screen will be dis-
played. If no buttons are press for 5 seconds after entering the File Selector mode, the unit will revert to the test 
mode.   The Scan button may also be pressed to re-enter test mode.

11.2  Autotest Mode
To use the Auto Test feature, connect the fi ber to be tested to a compatible test set. The unit being used as the 
source should be set to Autotest.  If Two Quad OTDRs are being used, only the wavelengths to be tested should 
be selected as sources by entering the Wavelength/Lambda selection menu. Only the wavelengths that are 
energized will be displayed on the power meter end.  Once the source and power meter have cycled through the 
wavelengths to be tested, press the Select button on power meter to store the measurements.  .  

Note: A reference measurement is not used in the Auto Test Mode.  The Source is modulated and has power 
level of -3dBm (-6dBm@1625).  This method of measurement does not take into account the launch condition, 
thus the manual method of testing should be used when highly accurate measurements are required such as 
when testing the loss of an individual connector.  The Auto Test annunciator will be displayed during Auto Test 
loss measurements.  Two or more loss measurements are best viewed in the Zoom mode where all the selected 
wavelengths will be display at one time on the display.  
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11.3  Light Source Operation

Energizing Light Source
The lasers are initially in the off state when the LTS is launched.  Enter the Menu mode and use the Scroll Wheel 
to highlight the Source soft key.  Pressing Select will energize the available wavelengths in sequence.

11.4  File View
Enter the File View by pressing the Menu button, scrolling to the Mode soft key and pressing Select.  Press  Menu 
to exit the Menu mode.  Use the scroll wheel to scroll through the stored traces.    The Store location in the bottom 
left of the screen will be changed to VIEW location. The value shown is the data stored in the displayed fi le loca-
tion. To exit the File View press the Menu button, scroll to the Mode soft key and press select.   

11.5  File Transfer 
To transfer fi les from the Loss Test Set to the computer, start the certifi cation software.  Connect the OTDR to 
the computer with the supplied USB cable,  Select Loss Test Set from the applications tabs.  To start the memory 
download, enter Menu mode on the OTDR, highlight the File Download Icon and press Select.   The download 
progress will be indicated by the UPLOAD counter in the bottom left corner of the LTS display and in the top right 
corner of the software screen.
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12.0 Video Scope / Visible Fault  Locator 

12.1 Video Scope Operation 
The FTE-7500A OTDR can accommodate the PRECISION RATE OPTICS Video Probe.  Located on the bottom 
panel is a an 8pin DIN connector labeled “Vid Probe” The OTDR can view a connector end face, center the image 
and zoom from 200X to 400X.  This feature is accessed from the Home screen.  From startup, scroll to highlight 
the Scope icon and press select.  If the instrument is in another application, press the Menu button, scroll to the 
Exit icon and press Select to return to the Home screen.  Insert the probe and turn on the probe light by moving 
the switch on the probe to the right.  The LED will illuminate indicating the probe light is on.  Insert a connector to 
the probe or insert the probe into a fi ber adapters and focus. Use the thumb wheel to focus the image. To zoom to 
400X, press  the Zoom button.  Pressing the Zoom button again will revert back to 200x.

12.2 Video Scope Display
                     
                   

         

                                 
                       
   

                                 

12.3 Adjusting Video Scope Image 
The Scroll Wheel has two functions in the scope application.  If the Adjust Contrast soft key is shown, the scroll 
wheel will change the contrast of the image.  With Adjust Position soft key is shown, the image may be centered 
by use of the scroll wheel when in the 400X zoom setting.  For positioning, use the scroll wheel as a left-right-up-
down feature by pressing those areas of the wheel.  

To change between Adjust Contrast and Adjust Position, press the Menu button and highlight the soft key.  Press 
Select to toggle between the features.  Press Menu to exit the menu mode to use the features.

Note
Only the Soft Keys and 
the Help Icon are acces-
sible on the Video Probe 
display

Return to Home Menu
 

    

Help Icon

Soft Keys

Fig 10.2

Fig 10.1
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12.4 Save and Recall Video Image
Store Video Scope Image to Memory

The Video image may be stored as a Bitmap by pressing the Menu button, scrolling to the Save soft key at the top 
of the display and pressing the Select button.  This will attempt to save the image to the location displayed next to 
the Save soft key.  If that location is occupied by a stored image, a dialog will appear with the choice to overwrite 
that location, save to the next available location or cancel the process.  Scroll to the desired action and press the 
Select button. 
 
Recalling Stored Video Scope Image 
To view a stored image, scroll to the Load soft key and press select to view the image at the indicated location.   
Subsequent presses of the Select button will increment through the occupied storage locations.  

12.5 Copy/Delete Video Scope Image 
To copy or delete images, Press the Menu button and scroll to the Copy soft key.  Pressing select on the soft key 
will display a dialog that offers the option of coping all of the images to the PC via the USB/PC port or to a fl ash 
drive.  The dialog will also offer the option to delete all the stored  video fi les or cancel the process.  Scroll to the 
desired action and press the Select button. 
       

Note
Do Not Remove USB Flash Drive While Accessing.

12.6   Visible Fault Locator 
. 

WARNING
Never clean or look directly into the fiber optic connector or the end of fiber attached to the OTDR or VFL 
unit while they are energized, to do so will expose the user to laser radiation and could result in personal 
injury or instrument damage.

Visible Fault Locator Description
The Visible Fault Locator (VFL) is a stabilized fi ber optic laser source that emits visible (red) light at 650nm.  
Its intended function is to allow an operator to identify fi bers or fi nd the exact location of a break, micro bend, or  
other discontinuity in a fi ber optic cable. As the radiation is visible, light emanating from a break or micro bend  
enables the user to locate the exact position of a fault even at very short distances that would not be detectable  
by other means. It is also useful for identifying a particular fi ber in a cable by exciting the fi ber to be located with  
visible radiation.  

Visible Fault Locator Operation 
This feature is accessed from the Home screen.  From startup, scroll to highlight the VFL icon and press select to 
cycle through VFL through CW (constant wave) mode or MOD (modulated) mode and Off. If the instrument is in 
OTDR or LTS mode, press the Menu button, scroll to the Exit icon and press Select to return to the Home screen. 
When in the Video Probe mode scroll to the Exit soft key and press Select to return to the home screen.   

Note
When in the OTDR application and the VFL is required, the active trace will not be lost by                                                                               
exiting to the home menu.
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Power button turns the unit On and Off. 
(Hold for 1 second)                                  

Scan button starts or stop a scan,  and resets the table of 
data.            

This button is disabled for 8 Channel CWDM Channel Ana-
lyzer.

Menu toggles the focus of the Scroll Wheel between the Scan Mode and the Menu Mode.  In Scan 
mode the focus of the Scroll Wheel and the Select Button are on the active cursor.  In Menu Mode, the 
Scroll Wheel moves through the Soft Key Menu and the Side Icon Bar. 

Toggles between “A” and “B” as the active cursors.

 

This button is disabled for 8 Channel CWDM Channel Analyzer.

The Select button actuates the highlighted item. 

While in Scan Mode, the scroll wheel moves the cursors.  While in Menu Mode, the scroll wheel is 
used to move through the soft keys and icons.  

Chapter 8   Operation

8.0   Operation

Fig 8.1

8.1   Key Pad Operation
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Chapter 8   Operation Continued

8.2 Display

Scan 
Status 

Indicator

A/B Cursors

Grid
Values

Channel Numbers and 
Selected Power Levels

Scan Measurements
See Fig.8.3

Soft Keys

Channel
Numbers

Fig 8.2

Active Cursor 
Indicator and 

Selector

Quick Save
 Soft  Key

Quick Recall 
Soft  Key

Displayed 
Power Indicator 

and Selector

dB Scale

Icon Bar

Scan Measurements

“A” Cursor Wavelength/
Frequency and Power

Fig 8.3

“A” to “B” Deviation in dB

Total Power

“B” Cursor Wavelength/
Frequency and Power
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Chapter 8   Operation Continued

8.3  FTE-7800 Operation

Warning
Care should be taken as skin or eye damage could result from high power devices such as transmitters 
or EDFAs. 

Caution
The FTE-7800 Channel Analyzer is designed to test a total power of  23dBm.  Attempting to test a total 
power above 23dBm will cause damage to this instrument.

Caution
Fiber-optic connectors are easily contaminated or damaged.  The connection to the FTE-8000 is a physi-
cal contact type of connection and dirty or damaged connectors may impair the instruments capabilities 
at minimum and at worst result in the need to return the FTE-8000 to the factory for expensive repairs.  
Prior to making any connection to the unit, ensure that all proper cleaning procedures have been fol-
lowed. Use UPC Finish Connectors Only!

Start the CWDM Channel Analyzer
Enter the CWDM Channel Analyzer operation from the home screen by using the scroll wheel to highlight the 
OSA  icon and press Select.  

Start a Scan 
Ensure the connector to be inserted into the optical port of the channel analyzer is clean and not 
damaged.  Insert the connector and press the Scan button to start a scan.  

The wavelength/frequency and  power are shown at the top right corner of the display in blue for the “A” cursor 
and red for the “B” cursor.  Just below the power reading for the cursors is the deviation between the power levels 
of the channels selected by the cursors and below that is the total power measurement.  Refer to Figure 8.3.   
Total power is the power that is present on the fi ber.  The total power measurement is displayed in dBm.  

8.4  Table 

The table located in the bottom right of the display indicates power levels for the 8 CWDM channels, listed 1-8 
with 1471nm being number one and 1611nm being number eight.  The power level displayed is controlled by 
the Power soft key at the top right of the display.  There are four options when displaying power.  Show Power 
indicates the real time power of each channel.  There are also Show Min, Show Max and Show Avg options.  To 
select the desired power level to be show, press the Menu button, scroll to the Show XXX soft key and press 
Select to cycle through the four choices.  These measurements are real time and accumulated during the length 
of a scan. 
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Chapter 8   Operation Continued

8.5 Unit of Measure 
The units of measure are wavelength or frequency.  The Lambda icon is used to change the unit of measure 
between nanometers or terahertz.   This will change the A-B span measurement to the left of the λ icon and the 
measurements displayed for each cursor.  To change the unit of measure, enter the menu mode by pressing the 
Menu button and scrolling to the Lambda icon.  Once highlighted, pressing the Select button will toggle between 
nanometers or terahertz. Press the Menu button again to return to the Scan Mode.

8.6 Quick Save/Recall
A scan may easily be stored to memory by using the Save soft key. To do this, enter the menu mode, scroll to the 
Save soft key and press the Select button.  The scan will be saved to the location indicated.  If that storage posi-
tion is full, a dialog will be displayed with the options of overwriting the fi le, storing to the next available location or 
canceling the command.   Use the scroll wheel to highlight the desired action and press Select.  The action will be 
complete and the display will return to the scan mode.  

Any fi le saved with this method will use the base fi le name of the last manually entered fi le and increments the 
suffi x by one.

To use the quick Recall feature, enter the menu mode and scroll to the Recall soft key.  Pressing the Select button 
will recall the scan stored in the indicated storage location.  Continued selecting of recall will cycle through any 
stored scans and when the last stored scan is reached,  continued selection will start back at the fi rst occupied 
storage location.  Press the Menu button to return to the scan mode.
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The OSA has the capability to store up to 1000 scans.  Once stored, these fi les may be copied to a PC via 
a USB cable or copied to a USB fl ash drive. To enter fi le management, press the Menu button, scroll to the 
File Management icon and press the select button. The fi les are listed in order of fi le storage position with an 
xxxxxxxx.OSA (8.3) naming convention.  Use the Scroll Wheel to move from one stored scan to another.  As a 
fi le is highlighted the time and date stamp are displayed with total and peak power information and the number of 
channels measured.  There is also a preview map of the scan displayed.  

10.1   File Management Display

Fig 10.1

Chapter 10   OSA File Management
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Exit File Management
There are two methods to return to the scan screen from the fi le management area.  First is to enter the menu 
mode, scroll to the Exit soft key and press select.  The second is to press select while a fi le is highlighted, this will 
open the scan screen with the highlighted fi le displayed. 

Copying Files to a Personal Computer
With the use of the supplied certifi cation software and USB cable the stored fi les may be copied directly to a PC.  
Highlight or Mark (see Marking Files on the next page) the desired fi le/s to be copied and scroll to the Copy PC 
soft key.   Press Select to move the fi les to the computer when directed  to do so in the certifi cation software.

Copying Files to Flash Drive
To Copy fi les to a fl ash drive, insert a fl ash drive (not to exceed 4Gbits in capacity) into the fl ash drive port.  High-
light or Mark (see Marking Files on the next page) the desired fi le/s to be copied and scroll to the Copy USB soft 
key. Press Select to copy the fi les to the root directory of the fl ash drive.  

Naming a File
The Name soft key may be used to name a fi le for a new scan to be saved or to rename a currently stored fi le.  
Files stored with the Save soft key will take the base name of the last named fi le.  To start a new set of scans 
with a new base fi le name, enter the menu mode while the fi rst scan is displayed.  Scroll to the desired storage 
location for the fi rst scan of the project.  Press the Menu button, scroll to the Name soft key and press Select.  The 
storage location will display a black box with a .OSA extension.  Use the Scroll Wheel to cycle through the avail-
able characters.  The available characters are (space), 0-9, A-Z and a-z.   Press Select to enter the character and 
move to the next character.   Once the desire fi le name is in place, press the Menu button and “Save Changes 
or Discard Changes” will be displayed in the soft key bar.  Scroll to highlight Save Changes and press the Select 
button to complete the action.  

10.2   Viewing a Store Scan

Chapter 10   File Management Continued

To view a scan that has been stored in the fi le management area, press the select button while the desired fi le is 
highlighted and the fi le will open in the scan mode.

10.3  File Management Soft Key Functions
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Renaming a File 
To rename a fi le, highlight the fi le to be renamed, press the Menu button and scroll to the Name soft key.  Press 
select and the fi rst character of the fi le name will be highlighted.  Continue to name the fi le as described earlier, 
press menu when done to either save changes or discard changes.

Deleting Files
To delete fi les, Highlight the fi le or Mark fi les (see Marking Files below) to be deleted.  Press the Menu button and 
scroll to the Del soft key.  Press select and “Cancel or Confi rm” delete will be displayed in the soft key bar.  Use 
the scroll wheel to highlight the desired action and press Select. 

Marking Files
Mass Copying and deleting can be accomplished with the Mark soft Key.   Highlight the fi rst fi le to be copied 
or deleted, press the Menu button, scroll to the Mark soft key and press Select.   Use the scroll wheel to move 
through the fi les.  Moving clockwise marks any fi les that are passed and move counter clockwise un-marks any 
fi les that are passed. Marked fi les will be displayed in red.   Press the menu button again and select the desired 
soft key function to be completed.  

Viewing Scans from a USB Flash Drive
The FTE-8000 can view fi les from a USB Flash drive.   Insert the USB Flash drive into the proper port and enter 
the menu mode.  Scroll to highlight the USB soft key and press the Select button.  The FTE-8000 will read any 
.OSA fi les in the root directory of the fl ash drive.  Highlight the fi le to be viewed and press the Select button.  To 
exit the fl ash drive directory, press the Select button a second time while the USB soft key is highlighted and the 
focus will revert back to the on board fi le management system.

Chapter 10   File Management Continued

Note
The file name is formatted as  xxxxxxxx.OSA (8.3) style.  The file storage system uses the eighth, sev-
enth then the sixth position to make the file name unique with an identifier digit.  Therefore depending on 
how many files need to be saved for the group of test, it may be best to only use 5, 6 or 7 characters for 
the file name.  For example:  If a file name of bbbbbbb.OSA was give to the first scan, when the following 
scans are saved they will be named; bbbbbbb0.OSA , bbbbbbb1.OSA, bbbbbbb2.OSA and so on.  In this 
case if there were more then eleven scans, the next name would be bbbbbb10.OSA.  The name would 
be adjusted to accommodate the two digit identifier. With the storage capability of up to 1000 scans, the 
identifier could possibly use up to three positions.  It is suggested that this be taken into consideration 
when creating the base file name.
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11.2   Calibration and Verifi cation
Periodic verifi cation of the FTE-8000 is recommended to ensure that your instrument remains within specifi cation. 
Although not imperative, we recommend a calibration and verifi cation once a year to make certain the instrument 
is functioning properly and performing to its rated specifi cations. Consult the factory for service.

11.3 FTE-7800 Adapter Replacement
The FTE-7800 is supplied with two easily interchangeable adapters per port, SC/FC. To change an adapter, re-
move the two screws that hold the adapter in place, pull the adapter straight up from ferrule.  It is suggested that 
you clean the exposed ferrule with appropriate cleanser and lint free wipe anytime you replace the ferrule.  

Chapter 11   Maintenance

11.1   Battery Replacement

Note
For maintenance, batteries require a monthly recharge.

Note
In order to maintain a low loss fiber connection, care should be taken to adequately clean the ferrule of 
any connector to be connected to the OSA.   In the event that the port needs to be cleaned, first step is 
to be certain the instrument is off.  We suggest the use of isopropyl alcohol and foam swabs specifically 
designed for cleaning connectors accepting 2.5mm ferrules.

Note
When replacing the adapter with one that does not have a chained protective cap, use the small screw in 
place of the larger screw that retains the end of the chain to the adapter base.    

Battery replacement is not recommended; however, if you must replace the batteries, follow this procedure.  
Unplug external power supply and ensure the unit is turned off.  Carefully remove unit from protective boot and 
remove the two screws from top plate and bottom plates that retain the back cover. Carefully remove back cover 
and remove the two screws that hold the battery covers in place.  Replace only with 8 high quality AA NiMH bat-
teries. Do not use batteries that are rated at less the 2500mAh.  If you install NiMH batteries that are dead or less 
than 1 volt each, charge these batteries for one (1) hour before using this unit. 

Warning
To Prevent Fire or Shock Hazard:

Do not install battery types other than those specifi ed by the manufacturer 
Do not use the charger without the batteries installed  
Do not expose the battery charger to rain or excessive moisture 
Do not use the AC adapter when there are signs of damage to the enclosure or cord 
Ensure that you are using the correct charger for the local line voltage  
Do not use any other charger than the one provided with this instrument. 

Failure to follow these caution statements may void the warranty of this equipment. 



50 FTE-8000 Users Guide Revision C  3/2012

Specifi cations are subject to change without notice

Chapter 12   Specifi cations

General 
Display 4 in Color TFT

Memory Type Internal and Flash Drive

Battery Rechargeable NiMH - 8 hours operating time

Storage Temperature -20 to 60 C

Operating Temperature 
Range -10 to 50 C

Dimensions (w/out rubber 
boot )

7.75” L x 4.5” W x 2.25” H   
(197mm L x 114mm W x 57mm H)  

Weight 2 lbs

Environmental Operation -10°C to 50°C

Communications ports USB and USB Flash Drive Ports

Accessories Provided
Universal Power Adapter w/US, UK, Continental Europe, and Australian Plugs, 

Interchangeable FC/ST and SC Adapters, Windows/Telcordia SR4731 Software, 
Rubber Boot and Manual on CD

S p e c i f i c a t i o n s
OTDR  CWDM Channel Analyzer

Wavelength 1310/1550 nm Wavelength Range 1471-1611nm

Dynamic Range 36/34dB SM, Channel Spacing 20nm

Pulse Width 5 - 20,000 ns Channel Pass Band ±6.5nm

Units of Measurement km, kf, mi Channel Power Range +5dBm to -50dBm

Event Dead zone 1m Absolute Accuracy ±1 dB

Attenuation Dead Zone 4m Max Composite Power +23dBm

Resolution .125 - 32m PDL ±0.2dB

Distance Uncertainty
±(0.75m + 0.005% x 
distance + sampling 

resolution)
Adjacent Channel Isolation 30dB

Full Scale Distance Range 1-240km SM Measurement Time < 1/2 Second

Typical Real-time Refresh Rate 2 Hz Readout Resolution 0.01dB

Group Index of Refraction (GIR) 1.024  -  2.048 Return Loss >40dB

Linearity ± .05 dB/dB Optical Interface Universal UPC (FC/SC)

Connector Styles FC, ST, SC 
Interchangeable Graphical Display Bar Graph and Table 

View

Memory Capacity ~500 Memory Capacity 1000 scans
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Chapter 13   Specifi cations 

Visible Light Source
Emitter Type Laser Diode

Wavelength 650nm ±5nm

Connector Type 2.5mm Universal

Output Power 1mW Max.

Power Meter Specifi cations 
Detector Type InGaAs

Connector Type 2.5mm Interchangeable  

Dynamic Range +5 to -77dB (CATV - +25 to -57dB)

Calibrated Wavelengths 850,1300,1310,1490,1550,1625nm

Units of Measurement dBm, dB

Resolution .01 dB

Power Measurement  Uncertainty
± 0.18 dB under reference conditions, ± 0.25 dB from 0 to -65 dBm,

± 0.35 dB from 0 to +5 dBm 
and from -65 to -77 dBm

Auto Test Range 0 to -40dB

Light Source Specifi cations 
Fiber Type Single mode

Wavelengths 1310, 1550  ±20nm

Output Power 0 dBm  (-3dBm @ 1625nm)

Laser Safety Classifi cation Class I Safety Per FDA/CDRH and IEC-825-1 Regulation

Modulation Modes CW, 270 Hz, 1000 Hz, 2000 Hz 

Specifi cations are subject to change without notice

Continued
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13.1   Warranty Information
This product, including all mechanical, electrical, and optical parts and assemblies are unconditionally warranted 
to be free of defects in workmanship and material for a period of one (1) year from the date of delivery.
       
This warranty does not apply to expendable parts such as batteries or optical panel connectors, nor to any 
instrument or component which has been subjected to misuse, alteration, or fi ber connector damage. It is the 
customer’s responsibility to understand all the instructions and specifi cations prior to operating this instrument. 
This warranty does not extend to any loss or damage consequent to the failure of the warranted product.

13.2   Repair Information
If repair is required, simply call the factory for return instructions and a RMA number.

Chapter 14   Warranty and Repair
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Symptom Possible Cause Solution

LCD dark

Power not on Press ON/OFF key

Batteries require recharging Recharge batteries

Batteries are missing, in backwards 
or need replacement

Check polarity, replace batteries,
or contact factory for servicing

LCD white Power cycled too quickly Turn off wait 10 seconds – turn on

Instrument locked Up Unexpected Operational Mode

Turn off (hold ON/OFF button in for 
1 second) wait 10 seconds – then 

depress On/Off again button to turn 
the unit on.

Activity indicator does not 
change to standby or active  
mode

Power cycled too quickly Turn off wait 10 seconds – turn on

Low or no power being dis-
played

Defective cord or dirty connector Replace or clean cord

Fiber Output port requires cleaning Clean and inspect port

Angle polish mated with UPC polish Examine connector ends for damage.  
Use UPC Connectors ONLY!

USB hookup to PC not func-
tioning properly

USB baud rate not set properly  or 
too quick for computer

Set port baud rate properly or de-
crease Baud rate in instrument and 

certifi cation software

PC drivers not set properly Un-install & re-install certifi cation 
software and drivers

USB Flash Driver not  func-
tioning properly

USB fl ash drive full Clean or use a new fl ash drive

USB fl ash driver cycled too quickly Turn power off wait 5 seconds turn 
back on
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17.0    Version Control
Through a program of continuous improvement the upgrade of the features and performance of this instrument 
are an ongoing process.  The version is displayed on Home Screen in the lower right hand corner of the display.   
The version changes and approximate release dates are as follows.

 
 V0.2 – 7/2012   -  Initial release date
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